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Introduction

I love that I’ve been able to write a book about projects in iMovie.

Editing video, after all, is a project in many ways. It often requires a 

good deal of time and attention to detail. It’s something you elect to 

do, probably in your spare time, because you want to document 

what happened at an event, or preserve memories, or communicate 

something in a way that text or photos alone are incapable of doing.

And I also love that I’ve been able to write a book about projects 

in iMovie. If you plucked a much younger me from the days when I 

first began editing video and showed me today’s iMovie, my brain 

would have had trouble processing what I was seeing (not to 

mention dealing with the fact that somehow I had been pulled 

through time). For as little as $15, or free when you buy a new Mac, 

you have the capability to edit high-definition video in real time, 

using a friendly interface that genuinely makes editing fun.

And let’s not even speculate how my brain would have reacted to 

editing HD video on the iPad, using iMovie for iOS.

Most of all, I love living in a time where these capabilities are 

available to millions of people who are willing to set aside some 

time and creativity. The future really is the best project.



xii Introduction

About the iMovie Projects
I call it The iMovie ’11 Project Book because I present the information in 
the form of projects: simple tasks you can do quickly that highlight an 
important concept or technique, and which you can build upon for your 
own video editing projects.

I’ve divided the book into the following seven chapters:

• A Primer on Shooting Video. It doesn’t matter the equipment, the 
experience, or the budget—shooting poor footage leads to mediocre 
movies. Here are some tips for improving the experience in the field.

• iMovie Fundamentals. Learn the building blocks of importing, 
editing, and working with features such as iMovie’s movie trailers.

• Organize Your Video Library. Video projects start with lots of clips, 
which can easily get lost or overlooked when it’s time to start cutting 
them together. Learn how to store, move, and mark footage, and how 
to use keywords to find clips quickly.

• iMovie Beyond the Basics. Replace clips, build a photo slideshow, 
correct color, adjust audio…find out how much more iMovie can do 
to make your video projects more interesting and enjoyable.

• Creative iMovie Projects. Using the skills you’ve learned, stretch 
iMovie’s creativity by making a travel highlights movie, a sports 
highlights movie, a music video, green-screen special effects, and a 
soundtrack using GarageBand.

• Share Your Movies. Don’t let your videos sit inert on a hard drive. 
Burn them to DVDs, share them on the Web, or transfer them to an 
iOS device, including the Apple TV.

• Edit Video on the iPad, iPhone, or iPod touch. You no longer have to 
wait until you get back to your Mac to edit video. Learn all about 
working with the iMovie for iOS app.

Although I’ve included a lot of great information, this book isn’t an ency-
clopedic look at iMovie. Jump in, enjoy yourself, and create something.



Introduction xiii

A Note About Conventions
When describing a command, I often need to direct you to a menu item. 
Since your eyes would glaze over if every mention was like, “Choose the 
Large item under the Viewer submenu of the Window menu,” I use a 
hierarchical shortcut that follows how you’d click the menu items: 
“Choose Window > Viewer > Large”.

I also frequently mention settings in iMovie’s preferences window. 
Rather than direct you to the command each time (choose iMovie > 
Preferences), I’m more likely to just write “In iMovie’s preferences…”

In terms of interacting with the software, the convention for describing 
the arrow you manipulate around the screen is a “mouse pointer,” even 
though in many cases you may be using a laptop trackpad or Apple’s 
Magic Trackpad instead of a mouse. Similarly, I talk about “clicking the 
mouse button,” which translates to single-clicking the button on the 
mouse or trackpad.

Lastly, I often refer to the “contextual menu,” which is a pop-up menu 
containing commands that apply to the element you’re working with. To 
access the contextual menu, either hold the Control key and click the 
mouse button or right-click the mouse.

Getting iMovie ’11
Unless you haven’t purchased a Mac in over a decade, you currently 
own a version of iMovie. Apple has shipped iLife (which also includes 
iPhoto, GarageBand, iDVD, and iWeb) free with every new Mac since 
2003, and has included iMovie on new Macs since iMovie 1.0 appeared 
in 1999. Look for iMovie in your Applications folder; it may also already 
be in your Dock. However, I can’t automatically assume you have 
iMovie ’11, the latest version, introduced in 2010. Most of the material in 
this book still applies if you’re running iMovie ’08 or iMovie ’09.

However, if your latest version is iMovie HD 6 or earlier, nothing will be 
familiar. Apple completely rewrote iMovie for the ’08 version, setting 
aside the old program in favor of a new approach. iMovie HD still works 
on modern Macs, although it’s no longer actively supported by Apple.
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There are three ways to get iMovie ’11:

• Buy a new Mac. This can be an awfully expensive way to buy a piece 
of software, but you get some very nice hardware thrown in with the 
deal. Seriously, if you’re contemplating a new Mac purchase anyway, 
the most recent Macs offer powerful processors, fast graphics 
processing (which can improve performance in iMovie), and the 
latest version of the iLife suite.

• Buy iLife at retail. For $49 from Apple, or from Amazon.com and 
other resellers, you get a boxed version of the suite on a DVD.

• Buy iMovie from the Mac App Store. Introduced in late 2010, the 
Mac App Store is an application on your Mac that lets you purchase 
software as direct downloads from Apple. (If you don’t have the App 
Store application, make sure you’re running Mac OS X 10.6.6 or 
later; from the Apple menu ( ), choose Software Update and install 
the latest version.) What’s great about the Mac App Store is that 
you can buy iMovie ’11 by itself for just $15. iPhoto ’11 and Garage-
Band ’11 are also available for the same price, but iWeb and iDVD—
which haven’t been updated since iLife ’09—are not. If you’re looking 
to upgrade from iLife ‘08 or earlier, go for the boxed set.



4
iMovie Beyond 

the Basics

Using the techniques covered so far, you can make all kinds of 

great videos in iMovie. Having a firm grasp of the basics helps you 

edit projects faster, so you’re spending more time enjoying your 

content and less time feeling your way through the software. But 

you’re bound to run into special situations: What to do when you 

want to fine-tune the way a transition works between two clips? 

What if your footage suffers from unexpected camera shake, or if 

the audio is muddled?

iMovie includes many tools for dealing with special situations, as 

well as for improving what you’ve already shot. For example, the 

color correction controls can boost saturation, adjust white balance, 

and apply eye-catching video effects. In this chapter, I also dig into 

advanced editing techniques and building photo slideshows.
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Learn Advanced 
Editing Techniques Project
Difficulty level: Intermediate

Editing video is a process of repeating a few movements—placing, 
trimming, adjusting—hundreds or thousands of times. So, you won’t be 
surprised that iMovie offers shortcuts to make the work easier. The tech-
niques described here are ones you can use in any movie project, and 
they focus on inserting clips and replacing existing clips with new ones. 
I also go into detail about the Precision Editor, a great way of making fine 
adjustments to the edit points of your clips, and about extracting audio 
from video clips, a valuable but often overlooked capability.

Insert a clip into the middle of another clip
In Chapter 2, I explained how to split a clip, a technique often used to 
drop a new clip into the space between the two segments. An easier 
method is to use iMovie’s Insert function.

Inserting a clip

1. In the Event browser, select a section of video you want to add to 
your project.

2. Drag the clip to the Project browser and drop it onto an existing clip 
(Figure 4.1).

Figure 4.1  
Drag a clip to 
be inserted.
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3. From the pop-up menu that appears, choose Insert (Figure 4.2).

The clip in the Project browser is split, and the new clip appears 
where you dropped it (Figure 4.3).

When you insert a clip, the next portion of the clip that got split 
continues where the first portion left off. If you’re looking to insert a 
clip but not interrupt the scene (for example, you want the audio from 
the first clip to continue while the inserted clip is visible), use a 
cutaway. See “Create a Cutaway Project,” later in this chapter.

Replace clips
I recommend assembling a movie fairly quickly, and then spending time 
later fine-tuning it. Often, you find that a clip you added isn’t as good as 
another one that would fit in the same place. Instead of deleting the clip 
and adding the new one, use the Replace commands. This option is 
particularly helpful when the incoming clip must remain the same dura-
tion as the one it’s replacing. 

Replacing clips

1. Drag a clip from the Event browser onto the top of the clip you want 
to replace in the Project browser.

Figure 4.2  
Choose an action.

Figure 4.3  
The inserted clip

tip
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2. From the pop-up menu that appears, choose one of the following 
(Figure 4.4):

• Replace. The incoming clip completely replaces the clip onto 
which it was dropped.

• Replace from Start. The first frame of your selection becomes 
the start of the replaced clip (just as the regular Replace function 
works). However, the duration of the clip remains the same as 
the clip you’re replacing.

So, for example, if you want to replace a 10-second clip in your 
project with a 5-second clip from an Event, choosing Replace 
from Start results in a 10-second clip. iMovie grabs 5 seconds 
outside your selection to fill the gap.

• Replace from End. Similar to the previous option, Replace from 
End uses the last frame of your selection as the anchor point 
when replacing a clip. In the example above, 5 seconds of addi-
tional footage are pulled from before the selection to maintain 
the original clip’s 10-second duration.

• Replace at Playhead. The first frame of your selection appears 
wherever you position the playhead and release the mouse 
button. In this case, using the example above, iMovie may grab 
footage from before or after the selection to fit within the 
10-second gap.

Remember, you can always open the replaced clip in the Clip Trimmer 
and adjust the visible portion of the footage without changing the 
duration: Click and drag in the middle of the selection to “slip” the clip.

If there isn’t enough available footage to perform a replace action, 
iMovie warns you that the edit will shorten the duration of the movie. 
In my example, if I were to select the first 4 seconds of the clip and 
drop it into the project using the Replace from End option, iMovie 
wouldn’t have enough source footage to fill the 10-second gap from 
the end. 

tip

note
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Original clip in project (10 seconds)

Active portion of clip using Replace (5 seconds)

Active portion of clip using Replace from Start

Active portion of clip using Replace from End

Active portion of clip using Replace at Playhead

Edit with the Precision Editor
Moving selection handles in the Project browser is a quick way to edit a 
clip, but it’s not always as precise as you’d like. The Precision Editor, like 
the Clip Trimmer, is another interface for editing clips, but in this case 
you get to manipulate the point where two clips meet (including a 

Figure 4.4  
I’m replacing a 
10-second clip in the 
project (top) with a 
5-second selection 
from the Event browser.  

To make it easier to see 
which footage is used 
with each Replace 
command, I’ve made 
the replacement and 
then opened the new 
project clip in the Clip 
Trimmer (below, with 
visible footage selected 
in yellow). In each case, 
the same 5-second 
selection was dragged 
to the original clip in 
the movie.
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transition if present), which is referred to as the cut point. Having this 
control is great for fine-tuning not just how a clip ends, but how it inter-
acts with the next clip in the movie.

The Precision Editor looks simple, but there are several ways to edit the 
elements surrounding a cut point. You can see exactly where two clips 
overlap, adjust the duration of a transition, and even offset a video clip’s 
audio without extracting it as a separate clip (a technique I discuss a 
few pages ahead).

To open the Precision Editor, do one of the following:

• Click the Action button on any clip and choose Precision Editor from 
the menu (Figure 4.5).

• If a transition appears between two clips, choose Precision Editor 
from the Action button that appears below the transition icon when 
you move your mouse pointer over it.

• Select a clip and press Command-/ (forward slash).

• For a faster, easier method, double-click the space between two 
clips; or, if a transition is present, double-click the space above the 
transition icon.

Editing video at a cut point

The Precision Editor displays the clips on either side of a cut point on 
two levels: the previous clip above and the next clip after (Figure 4.6). 
Visible footage appears in full color, while the hidden portion of a clip is 
dimmed.

Figure 4.5  
The Precision Editor 
pop-up menu item
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Next clipCut point

Previous clip Hidden footage

To adjust the cut point, use any of the following methods:

• Drag the center of the cut point left or right. This edit changes the 
duration of each clip but retains the duration of the overall project 
(Figure 4.7).

• Drag one of the clips left or right to reposition the cut point of just 
that clip. For example, dragging the top clip in the figure above would 
adjust where the clip ends. This technique changes the duration of 
the project, because you’re adding or removing frames from the clip.

• Click once on a clip to set that frame as the cut point. This is often a 
faster method than dragging the clip.

• Drag the cut point for just one clip (Figure 4.8). Doing so doesn’t 
change the cut point in the other clip.

Figure 4.6  
The Precision Editor

Figure 4.7  
Adjusting the cut point

Figure 4.8  
Adjusting the cut point 
for just one clip



80 The iMovie ’11 Project Book

To quickly preview how the edit looks, click the Play Current Edit button. 
iMovie plays three seconds of footage around the edit point.

Give yourself more room to work in the Precision Editor by minimizing 
the size of the Viewer. Choose Window > Viewer > Small, or press 
Command-8.

Adjusting the duration of a transition

Transitions appear on the middle bar in the Precision Editor and give you 
a good visual idea of which footage is being used to combine clips. You 
can also change the duration of a transition by dragging one of its side 
handles; the time appears as you drag (Figure 4.9).

You can change the transition style without opening the Transitions 
browser by double-clicking the transition in the Precision Editor to 
bring up the inspector. Then, click the Transition pop-up menu and 
choose a new style.

Offsetting an audio transition

One effective way to switch scenes is to start playing audio from the 
next clip before the visuals appear (think of a scene where dialogue 
from the previous clip bleeds over the visuals of the next clip, for 
example). Using the Precision Editor, you can change the audio’s 
offset by dragging a special audio cut point handle.

tip

Figure 4.9  
Changing the duration 
of a transition

tip
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1. Click the Show or Hide Audio Waveforms button to view the clips’ 
waveforms.

2. Drag the cut point within the audio portion left or right; the amount 
of offset appears at the top of the Precision Editor (Figure 4.10).

To offset the audio in both clips—and prevent overlapping sound—
hold Shift as you drag the audio cut point.

Editing extras in the Precision Editor

Other elements around the edit point, such as titles or sound effects, 
can be edited in the Precision Editor, too. Click the Show or Hide Extras 
button to reveal them (Figure 4.11). You can then change their durations 
or reposition them within the movie; you need to return to the Project 
browser to perform other edits, such as adjusting clip volume levels or 
title wording and styles.

Figure 4.10  
Offsetting an 
audio transition

Figure 4.11  
Editing extras
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Jump to other edit points without leaving the Precision Editor by 
clicking the space between clips in the Project browser; by clicking the 
circle icons in the Precision Editor; or by clicking the Show Previous 
Edit and Show Next Edit buttons.

Detach audio from a video clip
Nothing says you need to keep audio and video in sync throughout your 
movie. You may find a bit of dialogue or background noise that you’d like 
to use over different visuals. In that case, you want to extract the audio 
clip from its video clip, so you can work with the audio independently. 
iMovie provides two methods for doing this: detaching audio from a clip 
in the Project browser, or adding just the audio portion of a clip from the 
Event browser.

Let’s look at a couple of real-world examples. If you encounter unexpected 
audio in a scene—something drops, a person sneezes—or you just want 
to maintain an even level of background noise, you can borrow the audio 
from a different clip and hide the distraction. (Remember in Chapter 1 
when I recommended that you record ambient noise when shooting? 
Here’s where it comes in handy.) Or, perhaps you have a great line of 
dialogue, but the clip’s visuals aren’t as compelling as another clip’s. Here 
are two methods of using just the audio from other video clips.

Detaching audio from a video clip in the Project browser

1. Locate the clip that has the audio you want to use.

2. Select the clip and choose Clip > Detach Audio, or choose Detach 
Audio from the contextual menu. A new audio clip appears below 
the video, and the video track is muted (Figure 4.12).

3. Drag the detached audio to the section in your movie where you 
want it to appear.

Don’t forget to mute or lower the volume on the video clip over 
which you’re adding the new audio.

tip
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Distracting sounds

Clip muted

Detached audio clip

Adding just the audio from a video clip

1. In the Event browser, locate the section of the clip that has the audio 
you want to use.

2. Drag the selection to the Project browser, dropping it onto the top of 
a clip where you want the audio to begin.

3. From the pop-up menu that appears, choose Audio Only. The clip 
appears as an audio clip below the video (Figure 4.13).

Figure 4.12  
The original clip 
includes distracting 
sounds of dishes 
clattering in this café. 
The audio from the 
third clip contains a 
steady level of 
background noise. 
 
After detaching the 
audio to its own clip, 
I reposition it under 
the first, noisy, clip. 
Then, to hide the 
distractions, I mute 
the first video clip.

Figure 4.13  
Audio from a video clip 
added to the project
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Create a Photo Slideshow Project
Difficulty level: Easy

Much of this book is focused on bending video to your will, but don’t 
forget that iMovie can also import and work with digital still photos. 
They’re given the “Ken Burns Effect,” named after the famed documen-
tary filmmaker who popularized the technique of moving the camera 
over a still photo to give it a sense of motion. iMovie offers controls for 
customizing the effect, or ignoring it altogether. You can intersperse 
photos with video footage or, as I describe here, make a slideshow 
movie that’s composed entirely of photos.

Import photos
If you use iPhoto or Aperture to manage your photo library, or want to 
grab snapshots from Photo Booth, iMovie can access the photos directly. 
You can also import photos from the Desktop or other locations on your 
hard disk.

Importing photos from iPhoto, Aperture, or Photo Booth

1. Click the Photo browser button in the toolbar to view your photo 
libraries.

2. At the top of the Photo browser, select a photo source. Clicking the 
disclosure triangle to the left of the application name reveals your 
events, photos, faces, places, albums, and smart albums in the 
program (Figure 4.14).

Figure 4.14  
The Photo browser



Chapter 4: iMovie Beyond the Basics 85

3. In the lower portion of the browser, click a photo to preview it in the 
Viewer.

4. Drag the photo to the Project browser to add it to your movie. 
A green checkmark appears on the photo thumbnail in the Photo 
browser to indicate it’s in your project.

To view more thumbnails in the Photo browser, drag the separator 
between the libraries and the photos. Drag it high enough and the 
source list becomes a space-saving pop-up menu.

Importing photos from the hard disk

1. Locate the photo you wish to use in the Finder.

2. Drag the photo directly to iMovie’s Project browser, dropping it 
where you want it to appear in the movie (Figure 4.15).

Adding a source folder to the Photo browser

You can take advantage of the Photo browser even if you don’t use 
iPhoto or Aperture. Drag any folder from the Finder to the top pane of 
the Photo browser; it appears within a new folder called Folders, and it 
reveals its images when clicked.

tip

Figure 4.15  
Importing a photo 
from the Finder
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Adjust Ken Burns Effect settings
iMovie automatically applies the Ken Burns Effect to incoming photos. 
Also known as pan and zoom, the effect makes it appear as if the 
camera is moving over the surface of the photo, with a gradual zoom in 
or zoom out. It’s a technique that works especially well if you want to 
focus on something specific, like a person’s face, and then back out to 
reveal their surroundings. You can, of course, change how the effect 
appears by setting the start and end positions. If you’d rather remove 
the Ken Burns Effect, jump ahead to “Fit or crop a photo.”

Adjusting the Ken Burns Effect

1. Select the photo you wish to edit in the Project browser, and open 
the photo editing interface in the Viewer by clicking the Crop button 
on the toolbar; double-clicking the Crop icon in the corner of the 
photo clip’s thumbnail; or pressing the C key (Figure 4.16).

End frameStart frame Salted caramel ice cream

Crop icon Direction of motion

2. Drag the corner handles of the green Start rectangle to specify the 
appearance of the first frame of the effect; the area inside the rect-
angle will resize to fill the frame when played. Also, drag within the 
rectangle to reposition it (Figure 4.17).

3. Drag the corner handles of the red End rectangle to set the last 
frame. Click the Play button to preview how it will appear.

4. Want to swap the Start and End positions? Click the Reverse button.

5. Click Done to apply the changes.

Figure 4.16  
The Ken Burns Effect 
editing interface
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Start End

Reverse

Play button

Regardless of the original dimensions of the photo, iMovie crops the 
image to fill the video frame. As you can see in Figure 4.17, that ends 
up cutting off a fair bit of the image at the top and bottom. If you want 
to keep the full image in view, albeit with black bars at the sides, click 
the Allow Black button.

Now this is clever: When you add multiple photos at once, iMovie 
reverses the Ken Burns Effect settings for alternate stills. So, if the first 
photo zooms in, the second photo zooms out, and so on, to make a 
smooth viewing experience.

Fit or crop a photo
The Ken Burns Effect is snazzy, but too much panning and zooming can 
give your viewers a headache. If you want to display a photo without 
movement, set it to be either cropped to the frame or made to fit with 

Figure 4.17  
Setting the Start 
and End frames, 
and the result

note

tip
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black bars visible. The photo controls can also rotate photos, such as 
portrait-oriented pictures that were not automatically rotated when you 
imported them from the camera.

Fitting or cropping a photo

1. After adding a picture to your project, view the photo controls 
(I prefer to double-click the Crop icon or select the clip and press C).

2. Click the Fit button to get as much of the image into frame as 
possible (Figure 4.18).

Or, click the Crop button and then drag the frame’s corners to define 
the visible area. Cropping is also great when you want to focus on 
one area of an image and exclude another, just as you would crop a 
photo in iPhoto.

3. Click Done to apply the changes.

Fit Crop

If you set a Crop area and then decide to apply the Ken Burns Effect, 
the area you defined becomes the Start frame.

Rotating photos

1. Select a photo in your project and bring up the photo controls.

2. Click the Rotate Counterclockwise or Rotate Clockwise button to 
turn the photo in 90-degree increments.

3. Click Done.

Figure 4.18  
Fit and Crop

tip
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Change a photo’s duration
Incoming photos are given a 4-second duration by default, but you can 
make them as long as you want. Photos with the Ken Burns Effect 
applied automatically adjust the timing of the effect based on the clip’s 
duration.

Changing a photo’s duration

1. Double-click the photo you want to edit (or press the I key) to bring 
up the Clip inspector.

2. Enter a new time in the Duration field (Figure 4.19).

If you want all photos in your slideshow to match the same duration, 
click the “Applies to all stills” checkbox.

3. Click Done.

In iMovie’s Project Properties dialog, you can specify the default 
behavior of imported photos. For example, every new picture can be 
set to Crop instead of to the Ken Burns Effect, and can be set at a 
different  duration. Choose File > Project Properties, or press 
Command-J. Be sure the “Applies when added to project” option is 
enabled; otherwise the settings apply to all photos already within the 
project (Figure 4.20).

Figure 4.19  
Setting a clip duration

tip

Figure 4.20  
Photo-specific 
project settings
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Edit the rest of the slideshow
Now that you know the basics of adding and manipulating still images, 
continue to edit the rest of the slideshow movie using the editing tech-
niques discussed so far in the book. Rearrange clips to your liking; add 
transitions, titles, and music; and apply color correction and video 
effects to photo clips just as you would to video clips (see “Correct 
Color Project,” later in this chapter). (However, although iMovie’s color 
controls are surprisingly powerful, I recommend performing your 
primary image editing in iPhoto or other software before bringing 
pictures into iMovie.)

By far my favorite aspect of iMovie’s photo-editing features is this: 
The settings apply to video as well as to still images. Select a video clip 
in the Project browser, click the Crop button in the toolbar or press the 
C key, and you can apply a Ken Burns Effect to video, or crop the clip to 
remove distractions from the edge of the frame. (Cropping generates 
better results on HD footage, since the video must be enlarged to fit 
the frame after you’ve cropped it, reducing the resolution.)

Create a Cutaway Project
Difficulty level: Easy

A common video editing technique is to cut between scenes while a 
consistent section of audio plays. For example, someone is being inter-
viewed, and while you listen to them describe a place they visited, the 
image switches to video of that place. That clip is called a cutaway, and 
it’s easy to create in iMovie. Cutaways are also frequently used as a 
clever way to hide visual flubs: If you’re watching an interview and the 
camera cuts to the interviewer asking a question, chances are the 
subject being interviewed had to scratch his or her nose or take a drink 
of water just then.

Add the cutaway clip
If you’ve used a video editor such as Final Cut Express, you may miss the 
capability to overlay clips on multiple video tracks. iMovie offers just 

tip
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one video track—or does it? Although it’s not immediately obvious, 
iMovie does support a second video track for things like cutaways and 
picture-in-picture effects. That makes implementing a scene like this 
vastly easier than chopping clips and inserting other clips to accomplish 
the same task.

Adding a cutaway

1. In the Event browser, select a section of clip you want to use as the 
cutaway.

2. Drag the selection to the spot in your movie where the cutaway 
begins, dropping it directly onto the clip.

3. From the pop-up menu that appears, choose Cutaway (Figure 4.21).

The cutaway appears above the main video track. A shaded area 
indicates video is hidden in favor of the cutaway clip (Figure 4.22).

Footage hidden by cutaway

Cutaway clip

The advantage to this approach is that you can reposition or trim the 
cutaway clip without having to touch the base video clip at all. And 
because the cutaway is just a regular video clip, you can perform other 
edits and effects on it.

Figure 4.21  
Adding a cutaway

Figure 4.22  
The cutaway 
in the project
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Edit the cutaway clip settings 
You can also edit a couple of attributes that are specific to cutaway 
clips: whether it appears suddenly or with a fade-in (and disappears 
with a fade-out), and the opacity of the clip.

Applying a fade transition to a cutaway

1. Double-click a cutaway clip, or select it and press the I key, to bring 
up the Clip inspector.

2. Change the Cutaway Fade setting to Manual, and optionally change 
the duration of the fade (Figure 4.23). This setting applies to the 
start and end of the clip, and your only option is to fade the clip; you 
can’t choose other transition styles.

Changing the clip’s opacity

In the Clip inspector, drag the Opacity slider to adjust how transparent 
the clip appears (perfect for scenes of ghostly apparitions).

Create a Picture in Picture or  
Side by Side Scene Project
Difficulty level: Easy

Similar to a cutaway, the Picture in Picture feature provides the opportu-
nity to display a second clip without disrupting the main video, only in 
this case the clip appears in a box in the corner of the screen. Another 
option is the Side by Side effect, which splits the screen to display two 
clips at once. 

Figure 4.23  
Cutaway-specific 
settings
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Add the Picture in Picture or Side by Side clip
Creating a Picture in Picture or Side by Side clip works the same way as 
creating a cutaway, with the clip appearing above the main video track. In 
the case of the Picture in Picture effect, other controls are also available.

Adding a Picture in Picture or Side by Side clip

1. Select a range of video from the Event browser and drag it onto a clip 
in your project.

2. Choose Picture in Picture or Side by Side from the pop-up menu.

3. If you added a Picture in Picture clip, go to the Viewer and drag the 
clip to change its location within the frame. You can also resize the 
box by dragging the corner handles (Figure 4.24).

Edit the clip settings
Double-click the Picture in Picture or Side by Side clip to bring up the 
Clip inspector, where you’ll find settings specific to each effect, such as 
the option to apply a border style to the Picture in Picture clip.

Setting Picture in Picture options

• PIP Effect: This option controls how the picture box appears. From 
the pop-up menu, choose Dissolve for a fade-in effect, or Zoom to 

Figure 4.24  
Resizing a Picture 
in Picture clip
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enlarge the box from a corner. Then, set a duration for the effect 
using the slider (Figure 4.25).

The PIP Effect pop-up menu also includes a curious gem: Swap. 
When that’s enabled, the Picture in Picture clip occupies the entire 
frame while the base clip appears in the box.

• Border Width: Click a button to specify no border (the default) or a 
thin or thick border around the box.

• Border Color: “Color” is a bit of a stretch here, but if the Border 
Width is set to thin or thick, use this option to set the border as 
black, gray, or white.

• Drop Shadow: Click the Visible checkbox to make the box cast a 
subtle shadow.

Setting Side by Side options

• Side by Side: Choose on which side of the screen the Side by Side 
clip should appear, left or right (Figure 4.26).

• Slide: Click the Manual button and adjust the duration slider to make 
the clip slide into frame from the side specified in the pop-up menu.

Figure 4.25  
Settings for Picture 
in Picture

Figure 4.26  
Side by Side settings
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Stabilize Shaky Footage Project
Difficulty level: Easy

Not too long ago, if your footage exhibited camera shake—that slight 
bouncing or jittery motion introduced by shooting with a lightweight 
camera—either you compensated by locking the camera to a tripod, or 
you accepted the shaky video and passed it off as “edgy.” Now, iMovie 
can analyze and stabilize that footage.

Analyze for image stabilization
To smooth shaky video, iMovie analyzes each frame to identify similar 
objects. Then, it figures out how much zoom and rotation to apply to 
each frame to make the objects line up, effectively removing the shake.

Given that most clips contain 24 or 30 frames per second, analyzing for 
stabilization can take quite a while—four to eight times the duration of 
the original footage, or potentially several hours if you analyze a lot of 
video in one batch. Fortunately, you have several opportunities to 
perform the analysis, allowing you to analyze a large batch at once, or 
smaller sections as you edit.

Analyzing a clip for stabilization

You can analyze video at any of the following points:

• When you add video to iMovie, click the “After import analyze for 
Stabilization” checkbox in the Import dialog. iMovie scans all the 
footage being imported, tying up the program until it’s finished. This 
is a good option to use if you want to import a lot of video overnight 
while you’re sleeping.

• Select a clip in the Event browser and choose File > Analyze Video > 
Stabilization. The entire clip is analyzed, even if you’ve selected only 
a portion of it. (You can also choose to analyze for stabilization and 
people in the same pass.)

• Select a clip in the Project browser and choose File > Analyze 
Video > Stabilization. iMovie scans just the section in your movie, 
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not the entire clip in the Event browser. However, if you add more 
video from the same clip in your project, iMovie analyzes it again.

• Double-click a clip to bring up the Clip inspector. If the clip is in the 
Event browser, click the Analyze Entire Clip button (Figure 4.27). If 
you’ve selected a clip in the Project browser, click the “Stabilization: 
Smooth clip motion” checkbox.

If you have the time, I recommend analyzing clips in a large batch, 
such as during import. That enables you to apply stabilization during 
editing without having to wait for iMovie to scan footage on the fly.

Apply image stabilization
With your footage analyzed, you can control how much stabilization is 
applied. iMovie doesn’t actually re-render the video; instead, it keeps 
track of how much zoom and rotation each frame needs to match 
surrounding frames. 

Applying image stabilization

If the footage was previously analyzed in the Event browser, all you 
need to do is add the clip to your project; stabilization is automatically 
applied, indicated by an icon in the corner of the clip. For any clip in the 
Project browser that isn’t yet analyzed, open the Clip inspector (double-
click the clip, or select it and press the I key) and enable the 
“Stabilization: Smooth clip motion” checkbox.

To control the amount of stabilization applied, drag the Maximum Zoom 
slider in the Clip inspector. iMovie assumes you want the most stable 
footage, but you may want to ease back on the setting occasionally. If 
the clip has a lot of motion, iMovie must zoom further in to get frames 

Figure 4.27  
Stabilization button 
in the inspector

tip
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to match up—sometimes cutting out important sections of the scene, 
like slicing off the tops of people’s heads (Figure 4.28).

Some portions of clips contain too much camera shake for iMovie to 
compensate. You’ll see a squiggly red line to indicate those frames 
(Figure 4.29). To hide those sections, click the Hide Excessive Shake 
button.

Hide Excessive Shake button Excessive shake indicator

Compensate for rolling shutter
Many of today’s cameras use CMOS sensors, which record each frame 
in horizontal lines, scanning from top to bottom. When camera shake or 
sudden movement is introduced during shooting, the objects in the video 
appear “bendy,” like they’re made of rubber, due to an effect called rolling 
shutter. Although the best advice is to try to capture steady video in the 
first place, iMovie can help take the elasticity out of the clips (although 
the effectiveness varies widely, depending on the source footage).

Figure 4.28  
Maximum Zoom 
settings compared

tip

Figure 4.29  
Excessive shake
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Compensating for rolling shutter

1. Make sure the clip you’re editing has been analyzed for stabilization, 
and then open the Clip inspector. 

2. Under Rolling Shutter, click the “Reduce motion distortion” checkbox 
(Figure 4.30).

3. Choose a setting from the Amount pop-up menu; iMovie defaults to 
Medium, but try the other amounts to see if they improve the clip.

Correct Color Project
Difficulty level: Intermediate

As you know, the way to get the best picture when you shoot is to start 
with great original footage. However, that’s not always possible; maybe 
the white balance was set wrong, or lighting shifted while filming. Or, 
perhaps you just want to increase the saturation of a clip to make it pop. 
iMovie’s color correction tools are surprisingly effective, and they can 
help you tweak your image in subtle or strong ways.

The program also offers several video effects for when you want to 
dramatically change the appearance of your clips, from making them 
grayscale to applying an X-ray look.

Correct a clip’s color
If you’ve used the color correction tools in iPhoto, you’ll be familiar with 
the controls in iMovie.

Correcting color

1. Select a clip to edit; corrections apply to entire clips, so if you want 
to affect just a portion of a clip, you need to first split the section 
into its own clip.

Figure 4.30  
Rolling Shutter settings
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2. Open the Video inspector by double-clicking the clip and clicking the 
Video button in the inspector, or by just pressing the V key.

3. I recommend letting iMovie take the first stab at fixing color: Click 
the Auto button. If the clip looks good to you, click the Done button 
to close the inspector. Or, continue to the next step.

4. Using the controls in the inspector, make any of the following adjust-
ments (Figure 4.31):

• Levels. The histogram at the top of the window represents the 
levels of red, blue, and green in the current frame. The sliders 
below the graph represent the darkest and lightest values (pure 
black or white).

Drag the left slider toward the middle to darken the image; drag 
the right slider similarly to lighten the image. Doing so treats the 
furthermost colors on the outside edges as darkest or lightest. 

Figure 4.31  
Controls in the 
Video inspector



100 The iMovie ’11 Project Book

• Exposure. This slider brightens or darkens the video’s highlights.

• Brightness. This slider controls the overall lightness of the clip.

• Contrast. Accentuate the differences between light and dark.

• Saturation. Drag this slider to change the color intensity.

• Gain sliders. Adjust these slider values to compensate for color 
casts (to reduce a green tint, for example). The Gain sliders 
appear only when Show Advanced Tools is enabled in iMovie’s 
preferences.

• White Point. This control tells iMovie which color value equals 
white; the rest of the colors are based on that value. Move the 
point within the color wheel to adjust the white point, which can 
also affect the clip’s color cast. Or, click within the Viewer to 
specify which color should be treated as white (it also bases its 
settings on gray values).

• Revert to Original. If you don’t like the adjustments you made, 
click here to go back to the original settings.

For an example of the color adjustment controls in action, I used the 
settings in Figure 4.31 to bring out detail and color in an otherwise 
washed-out clip (Figure 4.32).

Original Corrected

Figure 4.32  
Color correction 
applied
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Color correction can be applied to clips in both the Project browser 
and the Event browser. So, you can adjust color before adding 
anything to your movie if you choose.

Apply video effects
If you’re looking for an easier way to change the appearance of a clip, 
choose from iMovie’s collection of 19 premade video effects.

Applying video effects

1. Select the clip you want to adjust.

2. Double-click the clip to bring up the Clip inspector.

3. Click the Video Effect button, which exposes a grid of the available 
effects.

4. Move your mouse over each effect to preview its appearance in the 
Viewer before making your choice (Figure 4.33).

5. Click the effect you want to use to apply it.

tip

Figure 4.33  
Previewing a 
video effect



102 The iMovie ’11 Project Book

With the effects picker visible, press the spacebar to play the selected 
clip in a loop. As you move your mouse pointer over the effects, the 
preview continues to play, using the option currently under the 
pointer to give you a better idea of how the effect works on the entire 
clip, not just one frame.

Unfortunately, you can apply only one video effect at a time, with one 
exception. If you want to make a clip black and white, and then apply 
an effect on top of that, do this: In the Video inspector, first drag the 
Saturation slider down to zero. Then, go to the Clip inspector and 
choose a video effect.

To remove an effect, bring up the Choose Video Effect window again 
and click the None option.

Change How a Clip Sounds Project
Difficulty level: Intermediate

Just as you can apply video effects to a clip, you can change how audio 
sounds by using several preset effects. Or, if you’re looking for subtler 
options, you can adjust the volume of background clips (“ducking”), 
change the audio balance using an equalizer, and filter background noise.

Apply audio effects
Want to make a scene sound like it’s in a larger room than the one in 
which you shot it? Make a person sound like they are talking on the tele-
phone or were transported from another planet? iMovie’s audio effects 
range from fanciful to practical.

Applying audio effects

1. Click the clip you want to edit.

2. Open the Clip inspector, and then click the Audio Effects button to 
bring up the Choose Audio Effect dialog (Figure 4.34). iMovie auto-
matically starts playing a preview of the clip.

tip

tip



Chapter 4: iMovie Beyond the Basics 103

3. Move your mouse pointer over an effect name to hear how it 
changes the audio.

4. Click the effect you want to use.

“Duck” a clip
Often, if someone is talking in a scene, you don’t want the volume of 
background music to drown out the dialogue. Using iMovie’s ducking 
feature, the background audio can automatically be lowered so it 
doesn’t compete. When the foreground clip ends, the background audio 
comes back up, without you having to make the adjustments manually.

Ducking a clip

1. Select the clip that you want to remain at regular volume.

2. Bring up the Audio inspector by double-clicking the clip and clicking 
the Audio button, or by pressing the A key.

3. Click the Ducking checkbox (Figure 4.35).

Figure 4.34  
Make Planet Claire 
sound like a real 
cosmic thing using 
audio effects.

Figure 4.35  
The Ducking checkbox 
and slider
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4. Adjust the slider to specify the volume level of other tracks that 
appear with the selected clip (Figure 4.36).

Normal With ducking applied

Change equalizer settings
It’s not the same as the giant mixing boards you’ll find in a sound studio, 
but iMovie’s equalizer can help you shape your clips’ audio. Presets like 
Voice Enhance, Music Enhance, and Hum Reduction are tailored to the 
sound recorded by video cameras.

Changing equalizer settings

1. Select a clip you want to edit.

2. Open the Audio inspector by double-clicking the clip and then 
clicking the Audio button in the inspector, or by pressing the A key.

3. From the Equalizer pop-up menu, choose a preset (Figure 4.37). 
Or, mark the Equalizer checkbox and adjust the sliders manually.

Figure 4.36  
The volume of the 
background song is 
reduced after ducking 
is enabled for the 
video clip.

Figure 4.37  
Equalizer presets
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Another common audio problem you’re likely to run into is varying 
volume levels among all clips in a movie. One thing to try is normal-
izing the clips: Select one, bring up the Audio inspector, and click the 
Normalize Clip Volume button.

Reduce background noise
If your video contains a persistent hiss or hum, or if there’s just enough 
background white noise in an environment to be distracting, you can 
filter the noise in iMovie. I’ve found this feature to be hit or miss, so it 
really depends on the audio in the clip—it’s better at minimizing subtle 
white noise than something more specific like wind noise. Still, it’s worth 
a try, and it’s easy to enable.

Reducing background noise

1. Select a clip you want to edit.

2. Open the Audio inspector by double-clicking the clip and then 
clicking the Audio button in the inspector, or by pressing the A key.

3. In the Enhance section, enable the “Reduce background noise by” 
checkbox and drag the slider to specify a percentage of the effect to 
apply (Figure 4.38). 

tip

Figure 4.38  
Reducing background 
noise
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Symbols
/ (forward-slash) to preview selected frames, 38

\ (backslash) for playback, 21

A
Action button (iMovie for iOS), 193

Action menu, 38

Add Selected Video to Project button  
(Toolbar), 32–33

Adobe Photoshop Lightroom, 28

“After import analyze for:” checkbox, 26

“After import analyze for Stabilization”  
checkbox, 95

AIC (Apple Intermediate Codec), 26

AirPlay button (iOS devices), 168

Alignment buttons (Font panel), 54

Allow Black button, 87

“Allow movie to be downloaded” checkbox, 156

ambient noise, recording, 14

Analyze Entire Clip button, 96

Analyze Video function, 68, 72

analyzing footage at import, 26

Aperture

accessing video from, 28

importing photos from, 84–85

Apple TV

playing videos from, 168

sending videos from iPads to, 168

turning on Home Sharing on, 167

watching videos on, 167–168

“Applies when added to project” option, 89

Archive All button (Import window), 27

Arrow tool, 33

aspect ratios

Aspect Ratio pop-up menu, 31, 35

formats, 6–7

audio

Audio Adjustments inspector, 48–49

Audio button, 151

Audio button (Media library), 188, 190

Audio Effect dialog, 102

Audio Inspector, 103–104

Audio Preview checkbox (GarageBand), 142

audio terminals (camcorders), 3

Audio Waveforms button (iPad 2), 187

capturing quality audio, 12–14

detaching from video in Project browser, 82–83

ducking background audio, 103–104

editing in iMovie for iOS, 187–192

equalizer settings, changing, 104–105

exporting finished audio (GarageBand), 142

fading in/out, 48–49

finalizing soundtrack (GarageBand), 140–142

recording with voiceover tool, 112–114

reducing background noise, 105

sound effects, adding in iMovie for iOS, 190

sound levels, setting (GarageBand), 136

audio clips

adding, 46–47

adding only audio from video clips, 83
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audio clips, continued

adjusting volume within, 49

applying effects to, 102–103

changing volume of, 47–48

detaching from video clips, 82–83

offsetting audio transitions  
(Precision Editor), 80–81

reducing background noise in, 105

Auto button (Video Inspector), 99

Auto-Apply mode (keyword tags), 69–70

autofocus mode, 12

automatic theme music (iMovie for iOS), 188

“Automatically add transitions and titles” 
checkbox, 115

“Automatically add (transitions)” checkbox, 31

Autoplay checkbox (QuickTime), 162

AVCHD (Advanced Video Codec High  
Definition), 8, 27, 30

B
background audio, ducking, 103–104, 189

background music

adding in iMovie for iOS, 187–189

adding to iDVD, 151–152

background noise, reducing (audio), 105

background songs, adding, 42–46

Ball James, 5

bass loops (GarageBand), 135–136

beat markers, 108–111

Best Performance burn mode, 152

Boogie Lights title, 53

bouncing screen effect, 12

brightness slider, 100

B-roll footage, 16

browsers, miscellaneous, 18, 20

Bulletin Board theme, 115, 117

burning discs (iDVD), 152–153

C
camcorders

importing video from tape-based, 29–30

overview, 2–3

Camera Roll

moving video clips to, 175

sharing projects to, 192–193

cameras

camera archives, importing, 30

importing videos to iPads from, 176

maintaining horizontal position of, 16

types of, 2–5

Canon

DSLRs, 4

PowerShot G12, 28

capturing

quality audio, 12–14

quality video, 8–12

video into iMovie, 174

Carlson, Jeff (author web site), 154

Carman, Robbie, 5

cell phones, for shooting video, 5

chapter markers, setting (iDVD), 146–147

Clip Settings window (iMovie for iOS), 187

Clip Trimmer, 41–42, 110–111

clipping levels (GarageBand), 136

clips

audio. See audio clips

Clip Inspector, 37, 92–93, 96

Clip Settings window (iMovie for iOS), 183

movie, adding to trailers, 36–37

clips, video

adding audio only from, 83

adding from media library to iPhone/ 
iPod touch, 176–177

adding to iMovie projects, 32–33

adding to movie trailers, 36–37

analyzing for stabilization of, 95–96

applying image stabilization to, 96–97

attaching audio clips to, 46–47

Clip Inspector, 37

Clip Trimmer, editing in, 41–42

correcting color of, 98–101

deleting in iMovie for iOS, 179

detaching audio clips from, 82–83
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editing at cut points, 78–80

editing in iMovie for iOS, 178–180

green screen clips, 121–122

inserting into middle of other clips, 74–75

moving on timeline (iMovie for iOS), 178

moving to Camera Roll (iMovie for iOS), 175

rearranging, 34

rejecting, 66–67

replacing, 75–77

splitting, 39–40

splitting in iMovie for iOS, 179

thumbnails, adjusting size of, 22

titles, adding to portions of (iMovie for iOS), 182

trimming (iMovie for iOS), 178–179

viewing favorite, 66

close-up shots, extreme, 16

CMOS sensors, 97

CNN iReport, sharing  
videos/photos to, 156–158, 193–194

color of video clips, correcting, 98–101

comment markers, 147

composing shots with rule of thirds, 10–11

compression

schemes for exporting videos, 159

of video formats, 8

contrast slider, 100

copying

Copy Files button (Import dialog), 30

or moving Events to different hard disk, 62–63

or moving projects to different hard disk, 64

regions (GarageBand), 140

coverage, maximizing video, 14–16

cropping

Crop button (Toolbar), 86–88

and fitting photos, 87–88, 90

green screen clips, 123

Cross Dissolves, 55

customizing

appearance of iMovie, 21–23

text appearance in titles, 52–55

cut points, editing video at (Precision Editor), 78–80

cutaway clips

adding, 90–91

settings, editing, 92

cutaway shots, 16

D
deleting

favorite marks, 66

frames, 39

transitions, 56

video clips in iMovie for iOS, 179

depth of field, 11–12

detaching audio from video, 82–83

detaching audio from video in  
Project browser, 82–83

digital SLR cameras, 2

directional microphones, 12

disabling Ken Burns effect (iMovie for iOS), 186

discs, burning (iDVD), 152–153

drop zone items (iDVD), 150–151

DSLR (digital single-lens reflex) cameras, 4–5

ducking background audio, 103–104, 189

duration

of photos, changing, 89

of transitions, adjusting (Precision Editor), 80

of transitions, changing, 57

DV tape format, 3, 6–7

DVDs

creating. See iDVD projects

standard-definition, 146

E
editing

audio (iMovie for iOS), 187–192

beat markers, 111

content of theme transitions, 117

Edit button (Camera app), 175

Edit Drop Zones button, 150

Edit tool (advanced tools), 33

extras in Precision Editor, 81–82

Ken Burns effect in iMovie for iOS, 185–186
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editing, continued

with Precision Editor, 77–82

settings for cutaway clips, 92

slideshows, 90

text in titles, 51–52

title and menu text (iDVD), 149–150

titles for movie trailers, 36–37

transition settings, 56–57

transitions in iMovie for iOS, 180–181

video at cut points with Precision Editor, 78–80

video clips in iMovie for iOS, 178–180

editing audio

audio clips, adding, 46–47

audio clips, adjusting volume within, 49

audio clips, changing volume of, 47–48

background songs, adding, 42–46

fading audio in/out, 48–49

editing video

in Clip Trimmer, 41–42

fine-tune trimming in place, 40–41

trimming footage in Project browser, 38–40

effects

applying to audio clips, 102–103

applying to video clips, 101–102

Audio Effect dialog, 102

bouncing screen, 12

green screen, 120–124

instant replay, 58

Ken Burns. See Ken Burns effect

Music and Sound Effects Browser button, 108

Music and Sound Effects browser (Toolbar), 43–44

Music and Sound Effects button, 143

One-Step Effects, 58

PIP (Picture in Picture), 92–94

previewing video effects, 101

rolling shutter, compensating for, 97–98

Side by Side, 92–94

sound effects, 190

Video Effect button, 101

encoding, video, 8

Ending title style, 182

end-of-project marker (GarageBand), 142

equalizer settings, changing (audio), 104–105

establishing shots, 15

Events

creating new, 62

Event browser, 18, 20

Event Library, 18, 20

merging, 61

moving/copying to different hard disk, 62–63

renaming, 60

splitting, 61–62

Excessive Shake indicator, 97

exporting

finished audio (GarageBand), 142

iOS projects to iTunes, 194–195

video from iMovie, 158–159

exposure slider, 100

extras, editing in Precision Editor, 81–82

extreme close-up shots, 16

F
Facebook, sharing videos/photos to, 156–158, 

193–194

fading

audio in/out, 48–49

audio in/out (GarageBand), 141–142

fade transition, applying to cutaways, 92

video in/out (iMovie for iOS), 173

FairPlay DRM scheme (Apple), 189

favorite footage, marking, 65–66

favorite loops (GarageBand), 137

filtering

Filter by Keyword checkbox, 71

footage with keyword tags, 71

Finder, importing photos from, 85

fine-tune trimming in place, 40–41

fitting/cropping photos, 87–88
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Flickr, exporting video to, 158–159

Flip cameras, 3–4, 174

focus rings, manual (camcorders), 3

fonts

Font panel, iMovie, 53–54

System Fonts panel, 54–55

footage

filtering with keyword tags, 71

finding people in, 68

locating with keyword tags, 71–72

marking favorite, 65–66

stabilizing shaky, 95–98

formats, video, 6–8

Four Corners title, 52

frames

adjusting number per thumbnail, 22

deleting, 39

Frame Rate pop-up menu, 31

making/adjusting selection of, 38

From Still to Motion: A photographer’s guide to 
creating video with your DSLR, 5

FTP (File Transfer Protocol), 164

G
gain sliders, 100

GarageBand

iPad version of, 170

library, 151

GarageBand project

bass loops, adding, 135–136

copying regions, 140

creating new sections, 134–136

Edgy Rock Guitar loops, adding, 138–140

exporting finished audio, 142

favorite loops, selecting, 137

finalizing soundtrack, 140–142

finishing film in iMovie, 143

importing videos into GarageBand, 125–127

installing extra loops/instruments, 130–131

instruments, adding, 132–134

Loop browser, opening, 128

loops, adding, 128–129, 131–132

new instruments, adding, 138–140

overview, 124–125

resize pointer usage, 137–138

sound levels, setting, 136

Take Control of Making Music with GarageBand ’11 
(Tolbert), 125

Take Control of Recording with GarageBand ’11 
(Tolbert), 125

transposing regions, 138

Getting Started Video (iWeb), 160

Gorillapod tripods, 9

Gottschalk, Matt, 5

GPS technologies in iOS devices, 182

green screen

edits, 20

effect, 120–124

Group Events By Project option, 64

H
H.264 encoding, 8

handheld shots, 10

hard disks

free space required for iDVD, 148

importing photos from, 85

importing video from, 30

Harrington, Richard, 5

HD (High Definition) video, 6–7

HDV (High Definition Video) recording, 8, 27

headphones, monitoring audio  
recording with, 13–14

Hide Excessive Shake button, 97

“Hide movie on my Gallery home page”  
checkbox, 156

High Quality burn mode, 153

Home Sharing, 167

horizontal orientation of video cameras, 16

hot shoe connectors (camcorders), 3
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I
iDVD projects

background music, adding, 151–152

burning discs, 152–153

chapter markers, setting, 146–147

choosing themes in, 148–149

drop zone items, adding, 150–151

editing title and menu text, 149–150

iMovie ‘08 and iDVD ‘08 for Mac OS X: 
Visual QuickStart Guide (Carlson), 154

previewing, 152

sharing to iDVD, 148

standard-definition DVDs and, 146

user guide, 154

images

resolution of, 6

stabilization feature, 9

iMovie

customizing appearance of, 21–23

exporting video from, 158–159

iMovie ‘08 and iDVD ‘08 for Mac OS X: 
Visual QuickStart Guide (Carlson), 154

iMovie for iOS

audio clips, changing volume of, 187

background music, adding, 187–189

editing transitions, 180–181

editing video clips, 178–180

fading in/out, 173

importing photos from Photo app, 184–185

Ken Burns effect, editing, 185–186

location data, embedding in  
videos/photos, 182–184

playing/skimming video, 177–178

projects, adding video to, 174–177

projects, creating new, 170–172

projects, opening existing, 174

sending projects between devices  
via iTunes, 194–196

sharing projects to Camera Roll, 192–193

sharing videos to YouTube/Facebook/Vimeo/
CNN iReport, 193–194

sound effects, adding, 190

themes, choosing, 172–173

titles, adding, 181–182

versions of, 170

voiceovers, adding, 191–192

iMovie projects

adding clips to, 32–33

creating movie trailers, 34–37

creating new, 31

One-Step Effects, 58

rearranging clips, 34

titles, adding. See titles

transition settings, editing, 56–57

transitions, adding, 55–56

importing

camera archives, 30

Import dialog, 25–26

photos, 84–85

photos from Photo app (iMovie for iOS), 184–185

video from hard disks, 30

video from memory-based cameras, 24–27

video from tape-based camcorder, 29–30

videos into GarageBand, 125–127

videos to iPads from camera/iPhone/ 
iPod touch, 176

in point/out point shots, 16

Insert function, 74–75

Inspector mode for keyword tags, 70

instant replay effect, 58

interface, iMovie

customizing appearance of, 21–23

overview, 18–20

interlaced video recording, 7

iOS devices

iMovie for. See iMovie for iOS

playing videos from, 168

synchronizing videos with, 166–167

iPads

Audio Waveforms button (iPad 2), 187

capturing videos into iMovie from, 174–175
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editing environment (iMovie for iOS), 171

importing videos from camera/iPhone/ 
iPod touch, 176

iPad Camera Connection Kit, 175, 184

Precision Editor in iPad 2, 180

sending videos to Apple TV from, 168

skimming timeline on, 178

turning on Home Sharing on, 167

iPhones

adding video clips from media library to, 176–177

capturing videos into iMovie from, 174–175

editing environment (iMovie for iOS), 171

HD video on (iPhone 4), 5

importing videos to iPads from, 176

resolution options (iPhone 4), 165

skimming timeline on, 178

transferring photos to iPads, 184

turning on Home Sharing on, 167

iPhoto

accessing video from, 28

importing photos from, 84–85

iPod touch

adding video clips from media library to, 176–177

editing environment (iMovie for iOS), 171

importing videos to iPads from, 176

resolution options, 165

skimming timeline on, 178

transferring photos to iPads, 184

turning on Home Sharing on, 167

iTunes

exporting iOS projects to, 194–195

iTunes Plus format, 189

playing videos with, 167–168

sending projects between devices via, 194–196

sharing videos/photos to, 165

turning on Home Sharing in, 167

iWeb

sharing videos/photos to, 160–164

Take Control of iWeb ’09 (Sande), 163

templates, 160

J
Joby (Gorillapod tripods), 9

Join Clip function, 40

K
Ken Burns effect

defined, 84

disabling in iMovie for iOS, 186

editing in iMovie for iOS, 185–186

settings, adjusting, 86–87

keyword tags

applying, 69–70

identifying people with, 72

locating footage with, 71–72

keywords, applying, 20

L
lavalier microphones, 13

layered audio clips, 47

location data, embedding in videos/photos 
(iMovie for iOS), 182–184

loops

adding to project (GarageBand), 131–132

bass loops (GarageBand), 135–136

Edgy Rock Guitar loops (GarageBand), 138–140

favorite (GarageBand), 137

Loop Background Music option, 188–189

Loop browser (GarageBand), 128

Loop checkbox (QuickTime), 162

loop families (GarageBand), 132

M
“Make this video personal” checkbox, 158

manual exposure controls (video), 4–5

manual focus, 12

manual focus rings (camcorders), 3

maps, adding to projects, 116–117

Master Volume control (GarageBand), 141

“Mastering iMovie trailers” article, 37

Maximum Zoom slider (Clip Inspector), 96–97
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measures, defined (GarageBand), 129

Media bin (iPad), 171

Media button, 150

media library video clips, adding to iPhone/ 
iPod touch, 176–177

medium shots, 15

memory-based cameras,  
importing video from, 24–27

menus

defined for DVDs, 148

text, editing (iDVD), 149–150

merging Events, 61

microphones

directional, 12

external, 12–13, 112, 192

lavalier, 13

Rode shotgun microphones, 12

USB, 112

Middle title style, 182

MobileMe, publishing web sites with, 163

MobileMe Gallery

sharing photos and videos to, 154–156

uploading movies to, 193

Mode switch (Import dialog), 25

Modern theme (iMovie for iOS), 172

modes, video, 152

Motion button (iDVD), 149

Move button (Camera app), 175

Move Files option (Import dialog), 30

Movie Track header, 127

movies. See also videos

movie trailers, creating, 34–37

Movies tab (Media browser), 127

MPEG-2/MPEG-4 compression, 8

multiple background songs, 44

multiple monitors, 23

Music and Sound Effects

browser (Toolbar), 43–44

browser button, 108

pop-up menu, 143

music video project, 108–111

muting audio sections/clips, 49

My Projects button (iMovie for iOS), 172, 174

My Projects screen (iMovie for iOS), 193–194, 196

N
Netflix, 154

New Project button (iMovie for iOS), 170

New Project dialog, 35

Nikon DSLRs, 4, 11

Noise Reduction slider, 113

None option (Choose Video Effect window), 102

Normalize Clip Volume button, 105

O
offsetting audio transitions (Precision Editor), 80–81

One-Step Effects, 58

opacity

changing in Clip Inspector, 92

setting (preferences), 54

Opening title style, 182

Optimize Video option (Import dialog), 26, 30

Outline tab, 36

P
people

finding in footage, 68

identifying with keyword tags, 72

viewing only footage marked with, 68

photos. See also sharing videos/photos

duration of, changing, 89

embedding location data in  
(iMovie for iOS), 182–184

fitting/cropping, 87–88

importing, 84–85

importing from Photo app  
(iMovie for iOS), 184–185

importing from Photo Booth, 84–85

Photo browser, adding source folders to, 85

Photos app, 176, 192
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Photos browser, 18

Photos button (Media Library), 185

rotating, 88

sharing to YouTube/Facebook/Vimeo/ 
CNN iReport, 193–194

Photoshop Lightroom (Adobe), 28, 30

Picture in Picture effect, 92–94

pinning background songs, 45–46

pixels, image resolution and, 6–7

Pixie Dust title, 53

Play button (Camera app), 174

Play button (Import dialog viewer), 25

Play Current Edit button, 80

Play Full Screen button, 21

Play Selected Events from Beginning button, 21

playhead

basics, 20–21

Playhead Info display, 70

scrubbing (iDVD), 149

splitting clips at, 40

playing

and skimming videos (iMovie for iOS), 177–178

videos, 20–21

Poster Frame slider (QuickTime), 162

PowerShot G12, 5

Precision Editor

audio transitions, offsetting, 80–81

editing extras in, 81–82

editing video at cut points, 78–80

fine-tuning edits with, 111

in iPad 2, 180

overview, 77–78

transitions, adjusting duration of, 80

Preferences

GarageBand, 142

iMovie, 20, 54

presets, equalizer (audio), 104

previewing

export settings, 159

iDVD projects, 152

movie trailer styles, 35

and playing video, 20–21

video effects, 101

Professional Quality burn mode, 153

progressive video recording, 7

Project browser

basics, 18–19

detaching audio from video clips in, 82–83

trimming footage in, 38–40

Project Library, 18–19

projects

moving/copying to different hard disc, 64

Project Info window, 153

Project Properties dialog, 89

Project Settings button (iMovie for iOS), 180

Project Settings window (iMovie for iOS), 173

Project Settings window (iPad), 188–189

publishing

to iTunes, 165

with MobileMe, 163

Publish button, 156

via FTP, 164

Q
QuickTime

controls (inspector), 162

files, saving with H.264 encoding, 8

R
Real Instrument tracks (GarageBand), 133

rearranging video clips, 34

recording

ambient noise, 14

Record button (Camera app), 174

sound effects, 190

with voiceover tool, 112–114

rectangular pixels (DV format), 6–7

Redo button on iOS devices, 184

reducing background noise (audio), 105
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regions (GarageBand)

copying, 140

defined, 129

transposing, 138

rejecting video clips, 66–67

renaming Events, 60

re-ordering background songs, 45

replacing video clips, 75–77

resize pointer (GarageBand), 137–138

resizing Picture in Picture clip, 93

resolution of images, 6

Retake button (Camera app), 175

Retina Display screens (iPhone/iPod touch), 165

Revert to Original setting (Video Inspector), 100

Rode shotgun microphones, 12

rolling shutter effect, compensating for, 97–98

rotating photos, 88

rule of thirds, 10–11

S
Sande, Steve, 163

saturation slider, 100, 102

Scene Selection button (iDVD), 151

scores, creating musical (GarageBand).  
See GarageBand project

scrubbing playhead (iDVD), 149

SD (standard definition) video, 6

SDHC cards, 2

sections of frames, marking as favorites, 65

selection of frames, adjusting, 38

selective focus, 11

Send Project to iTunes button (iMovie for iOS), 195

shaky footage, stabilizing, 9, 95–98

shallow depth of field, 11

sharing

projects to Camera Roll, 192–193

Sharing dialog (iTunes), 166

sharing videos/photos

to Flickr, 158–159

to iDVD, 148

to iTunes, 165

to iWeb, 160–164

to MobileMe Gallery, 154–156

to YouTube/Facebook/Vimeo/ 
CNN iReport, 156–158, 193–194

shots, types of, 15–16

Show Advanced Tools option, 20, 23, 65, 69

Show Audio Waveforms button, 47

Show Fine Tuning Controls button (Preferences), 40

Show Inspector button, 152

Show Media button (iWeb), 161

Show Movie Controller checkbox (QuickTime), 162

Show Previous Edit/Next Edit buttons, 82

Show/Hide Audio Waveforms button, 81

Show/Hide Extras button, 81

Show/Hide Keyword Filter Pane button, 71

Side by Side effect, 92–94

Single-Row View, 23–24

sizing Viewer, 22–23

skimming

defined, 21

and playing videos (iMovie for iOS), 177–178

sliders

gain, 100

Maximum Zoom (Clip Inspector), 96–97

Noise Reduction, 113

Opacity, 92

Poster Frame (QuickTime), 162

Project browser/Event browser, 22

Start and Stop (QuickTime), 162

Transition Duration, 57

volume, 187

slideshows

editing, 90

Ken Burns Effect, 84, 86–87

photos, changing duration of, 89

photos, fitting/cropping, 87–88

photos, importing, 84–85

slipping clips, 38

Snap to Beats (View menu), 108

Snap to Grid checkbox, 130
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Software Instrument tracks (GarageBand), 133–134

songs, adding background, 42–46

sound effects

adding in iMovie for iOS, 190

Music and Sound Effects browser, 43–44, 108

Music and Sound Effects button, 143

short audio files as, 189

sound levels, setting (GarageBand), 136

soundtrack, finalizing (GarageBand), 140–142

Space Saver feature, 67

Split days into new Events checkbox, 26

splitting

clips, 39–40

Events, 61–62

video clips in iMovie for iOS, 179

sports highlights movie project, 118–120

Sports Team Editor, 118

square pixels, 7

stabilization

analyzing for, 26

“Stabilization: Smooth clip motion” checkbox, 96

stabilizing shaky footage, 95–98

Standard (4:3) aspect ratio, 148

standard-definition (SD) DVDs, 146

Start and Stop sliders (QuickTime), 162

steadiness in handheld shots, 9

still cameras, 4–5, 24

Storyboard tab, 36

styles

for movie trailers, 35

of titles, changing, 52

transition, changing, 56, 80

Subtract Last Frame feature, 123–124

Swap Events and Projects button, 24

Swap option (PIP effect), 94

Swap transition, 55

synchronizing

Sync Movies checkbox (iTunes), 166

videos with iOS devices, 166–167

System Fonts panel, 54–55

T
Take Control of iWeb ’09 (Sande), 163

Take Control of Making Music with GarageBand ’11 
(Tolbert), 125

Take Control of Recording with GarageBand ’11 
(Tolbert), 125

tape-based camcorder, importing video from, 29–30

templates, iWeb, 160

text

editing in iDVD, 149–152

editing in titles, 51–52

themes

applying project themes, 115–116

automatic theme music (iMovie for iOS), 188

choosing (iMovie for iOS), 172–173

choosing in iDVD, 148–149

editing iDVD, 149–152

Sports theme elements, 119–120

theme transitions, editing content of, 117

three-CCD cameras, 3

thumbnails, clip, 22

timelines

background songs added to, 189

moving video clips on (iMovie iOS), 178

skimming in iMovie for iOS, 177–178

switching to traditional, 23–24

titles

adding, 50–51

adding in iMovie for iOS, 181–182

adding to portions of clips (iMovie for iOS), 182

changing style of, 52

customizing text appearance, 52–55

editing for movie trailers, 36–37

editing text, 51–52

editing text in iDVD, 149–150

Title browser, 50

Tolbert, Jeff, 125

Toolbar, 18, 20

tracks, defined (GarageBand), 128

traditional timeline, switching to, 23–24
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trailers, movie

creating, 34–37

“Mastering iMovie trailers” article, 37

transitions

adding, 55–56

adjusting duration of (Precision Editor), 80

editing in iMovie for iOS, 180–181

fade transition, applying to cutaways, 92

offsetting audio (Precision Editor), 80–81

settings, editing, 56–57

theme transitions, editing content of, 117

Transition browser, 55

Transition inspector, 56

transition placeholders, 180

Transition Settings window (iMovie for iOS), 180

transposing regions (GarageBand), 138

travel highlights movie project, 115–117

Travel theme (iMovie for iOS), 183

trimming footage

Clip Trimmer, 41–42

fine-tune trimming in place, 40–41

in iMovie for iOS, 178–179

in Project browser, 38–40

Trim to Selection function, 39

tripods/monopods, 9

U
Uncheck All button (Import dialog), 25

Undo button on iOS devices, 184

Unpin Music Track function, 46

uploading video to Flickr, 159

USB microphones, 112

Use button (Camera app), 175

user guide, iDVD, 154

V
video library

finding people in footage, 68

keyword tags, applying, 69–70

keyword tags, identifying people with, 72

keyword tags, locating footage with, 71–72

marking favorite footage, 65–66

organizing Events. See Events

overview, 59–60

rejecting clips, 66–67

viewing only footage marked with people, 68

videos. See also clips, video; sharing videos/photos

accessing from iPhoto or Aperture, 28

adding to iMovie for iOS projects, 174–177

applying effects to, 101–102

cameras, types of, 2–5

capturing into iMovie from iPhone/iPad, 174–175

capturing quality video, 8–12

clips. See clips, video

editing at cut points with Precision Editor, 78–80

editing for movie trailers. See editing video

embedding location data in  
(iMovie for iOS), 182–184

exporting from iMovie, 158–159

formats, 6–8

importing from hard disk, 30

importing from memory-based cameras, 24–27

importing from tape-based camcorders, 29–30

importing into GarageBand, 125–127

importing to iPads from camera/iPhone/ 
iPod touch, 176

maximizing coverage with, 14–16

playing from Apple TV, 168

playing from iOS devices, 168

playing in iTunes, 167–168

playing/skimming (iMovie for iOS), 177–178

previewing and playing, 20–21

sending to Apple TV from iPads, 168

sharing to YouTube/Facebook/Vimeo/ 
CNN iReport, 193–194

stabilizing shaky footage, 95–98

synchronizing with iOS devices, 166–167

uploading to Flickr, 159

Video Effect button, 101

Video Inspector, 99

watching on Apple TV, 167–168
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View menu (Event Library), 19

Viewer, 18, 20, 22–23

viewing

favorite clips, 66

only favorite clips, 66

only footage marked with people, 68

Vimeo, sharing videos/photos to, 156–158, 193–194

visual notes, shooting, 16

Voice Enhancement checkbox, 113

voiceovers

adding in iMovie for iOS, 191–192

recording voiceover project, 112–114

volume, audio

adjusting within clips, 49

changing, 47–48

changing in iMovie for iOS, 187

volume sliders, 187

W
waveforms

changing audio volume with, 47

fading with, 48

Web sites, creating with iWeb, 160–164

Web sites, for further information

cameras compatible with iMovie, 8

formats supported by QuickTime, 8

iDVD user guide, 154

Jeff Carlson, 154

Joby, 9

“Mastering iMovie trailers” article, 37

Rode shotgun microphones, 12

Take Control of iWeb ’09 (Sande), 163

White Point control (Video Inspector), 100

widescreen (16:9) mode, 148

widescreen aspect ratio, 6

Y
YouTube, sharing videos/photos to, 156–158, 193–194
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